How-To Guide

Manual Testing with SAP Solution Manager

Applicable Releases:
Solution Manager 7.0 EHP1 and above

Target groups:
Test Engineers, Quality Experts, Technology Consultants, Application Consultants

Author:
Mirco Rotzlawski

FEBRUARY 2011
# Table of Contents

1. **Introduction** ..................................................................................................................... 2  

2. **Prerequisites** ................................................................................................................... 3  
   2.1 General Requirements ...................................................................................................... 3  
   2.2 Basic Test Management Setup (one-time) ....................................................................... 4  
      2.2.1 Activate Solution Manager Services ........................................................................ 4  
      2.2.2 Setup Work Center for Test Management ............................................................... 7  
      2.2.3 Activate Workflow Functionality ............................................................................. 13  
      2.2.4 Set-Up Automatic E-Mail Notification for Testers .................................................... 15  
      2.2.5 Activate BI Reporting ............................................................................................. 20  
   2.3 Authorizations and User Parameters .............................................................................. 23  
      2.3.1 SAP Solution Manager System .............................................................................. 23  
      2.3.2 Managed System .................................................................................................... 24  

3. **Step-by-Step Procedure** .................................................................................................... 28  
   3.1 Project & Solution Documentation .................................................................................. 28  
      3.1.1 Create a New Project ............................................................................................... 30  
      3.1.2 Business Blueprint .................................................................................................. 34  
      3.1.3 Configuration .......................................................................................................... 39  
   3.2 Test Planning .................................................................................................................. 43  
      3.2.1 Create a Test Plan .................................................................................................... 43  
      3.2.2 Create a Test Package ............................................................................................. 47  
      3.2.3 Assign Test Package(s) to Tester(s) ......................................................................... 48  
      3.2.4 Release your Test Plan ............................................................................................. 50  
   3.3 Test Execution .................................................................................................................. 52  
      3.3.1 Perform a Manual Test ............................................................................................ 53  
      3.3.2 Set Test Status ......................................................................................................... 55  
      3.3.3 Create a Message ..................................................................................................... 56  
      3.3.4 Create a Test Note .................................................................................................... 58  
   3.4 Test Reporting .................................................................................................................. 60  
      3.4.1 Check Test Case Coverage for Business Processes ................................................. 60  
      3.4.2 Check Assignment of Test Cases to Test Plans and Test Packages ....................... 62  
      3.4.3 Check Status for Current Test Phase ....................................................................... 63  
      3.4.4 Check Messages for Test Plan .................................................................................. 65  
      3.4.5 Create a Test Report ................................................................................................ 66  
      3.4.6 Use Test Reporting Features Based on SAP BI ....................................................... 70
1. Introduction

SAP-centric solutions are changed on a regular basis through SAP or customer-triggered change events which require our customers to test their business processes thoroughly. Therefore, our customers constantly seek to improve their test management. They want to have robust solutions that can be rapidly implemented in their company and that allow them to increase their ROI. What is more, customers want to avoid the disadvantages that occur when using Excel spreadsheets for test planning.

To meet the above-mentioned needs, the SAP Solution Manager provides a range of appropriate tools which are already being used successfully by several thousand customers.

The focus of this How-To Guide is on manual testing, which constitutes an essential part of a company’s testing activities. The descriptions included in this document aim to enable Enterprise Support customers to rapidly set up professional manual testing. To that end, chapter 2.2 provides instructions describing the required setup and configuration steps in detail.

The author’s experience shows that even with little knowledge in the area of test management the basic setup/configuration can be done within approximately two days. Once the initial configuration has been completed, the manual testing capabilities can be productively used. Chapter 3 contains detailed explanations of how to use the functions for manual testing that are provided by the SAP Solution Manager.
2. Prerequisites

Before you can start with actual testing activities, a number of preparatory steps needs to be performed. Therefore, you have to make sure that the prerequisites explained in this chapter are fulfilled.

2.1 General Requirements

For the purposes of this document, the following assumptions are made:

- Initial- and Basic Configuration has been performed with transaction SOLMAN_SETUP

- Solution Manager local SLD (System Landscape Directory) is set up and contains technical system information of your managed system landscape

- Managed systems considered for testing are available in Solution Manager Landscape Management (transaction SMSY)

- Logical Components are in place and managed systems are assigned to according System Roles

- RFC destinations from Solution Manager to managed system and vice versa have been created

- Users have been created as system users and business partners (with role ‘Employee’) in SAP Solution Manager, and e-mail addresses have been assigned to the users
2.2 Basic Test Management Setup (one-time)

The following describes test management specific configurations that have to be made before you can productively use the manual testing functionalities within SAP Solution Manager.

Note

The settings explained in this chapter have to be made only once prior to productive usage. Hence, making these settings is a one-time effort.

The following gives you an impression of how much time is required to perform the basic test management specific setup:

<table>
<thead>
<tr>
<th>Basic Configuration (one-time activities)</th>
<th>Approx. Effort</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate Solution Manager Services</td>
<td></td>
</tr>
<tr>
<td>Setup Work Center for Test Management</td>
<td></td>
</tr>
<tr>
<td>Activate Workflow Functionality</td>
<td></td>
</tr>
<tr>
<td>Set-Up Automatic E-Mail Notification for Testers</td>
<td></td>
</tr>
<tr>
<td>Activate BI Reporting</td>
<td>2 days</td>
</tr>
</tbody>
</table>

Once you have performed the steps explained in detail below, you will be able to perform basic manual testing activities using the features explained in chapter 3. In addition, there is also a variety of advanced features which require further setup activities. The advanced features are, however, not part of this document.

2.2.1 Activate Solution Manager Services

As a first mandatory configuration step, you have to activate the services for the Web Dynpro applications "Sequences - Test Organizer" and "BI-based Test Workbench Reporting".

The service activation assures that the test cases in a test package can be sorted into a specified sequence (this is an advanced feature and therefore will not be dealt with in this document) and allows you to make settings for Test Workbench BI Reporting.

To activate the services, proceed as follows:

1. In the SAP Reference IMG, choose SAP Solution Manager Implementation Guide → SAP Solution Manager → Scenario-Specific Settings → Test Management → Standard Configuration → Activate Solution Manager Services.
2. Click on 🎨 to execute the IMG activity. This opens the Choose Activity dialog box.

3. In the Name of Activity column, place the cursor on Activate Service and click on ✂️ Choose.

The ICF: Report for Activating Special Service During Installation screen opens.

4. In the Technical Name field, enter SM_IMPLEMENTATION.

5. Choose Execute ( 🕵️‍♀️ ) to run the report. A screen opens to inform you that the services have been activated.

6. Choose the Exit pushbutton ( ⚪️ ).
Back on the Choose Activity dialog box, you can see that the activation of the service has been performed.
Optional:

To check the service activation, proceed as described below. The following only describes how to check the activation of the “BI-based Test Workbench Reporting” service. The “Sequences” service is not considered at this point, as it is part of the advanced features.

7. Place the cursor on **Check Service Activation** and click on Choose.

8. On the **Maintain Services** screen, enter **SERVICE** in the **Hierarchy Type** field and choose the **Execute** pushbutton.

The **Maintain service** screen opens.

9. In the Virtual Hosts / Services hierarchy, go to **default_host → sap → bc → webdynpro → sap → aicmsbi_twb_setup** (Set-Up Test Workbench BI Reporting).

10. Right-click on the service ‘aicmsbi_twb_setup’.

11. From the context menu, choose the option **Test Service**.
If the service has been properly activated, the following screen is displayed in your browser:

12. Close your browser and exit the Maintain service screen. Back on the Choose Activity screen, a green tick indicates that the check of the service activation has been performed.

13. Choose Exit (🗐) to return to the IMG.

2.2.2 Setup Work Center for Test Management

To be able to use work centers, you need work center roles as well as standard roles for the specific users. Standard roles contain authorization objects for functions, whereas work center roles determine the menu and therefore the navigation for the respective work center. You must assign authorizations in standard roles, and work center roles to your users.

There is only one work center role per work center. Each user also needs to have the role SAP_SMWORK_BASIC, which contains all necessary authorization objects that are relevant for using work centers.

While the focus of the following sub-chapters is particularly put on the Test Management work center, chapter 2.3 (Authorizations and User Parameters) contains general information on further roles and authorizations that are required in addition.

For more detailed information on roles and authorizations, please also refer to the Security Guide which can be found on the SAP Service Marketplace at:


2.2.2.1 Assign Test Management Work Center Role

To assign the Test Management work center navigation role to selected users, proceed as follows:

1. In the SAP Reference IMG, choose SAP Solution Manager Implementation Guide → SAP Solution Manager → Scenario-Specific Settings → Test Management → Standard
2. Click on \( \text{ } \) to execute the IMG activity. This opens the Role Maintenance screen.

3. In the Role field, enter SAP_SMWORK_ITEST.

**Recommendation**
We recommend that you copy the default roles delivered by SAP to your namespace. This allows you to adapt the roles to your specific needs without modifying the roles provided by SAP.
If you decide not to copy the role to the customer namespace, you can skip steps 4 – 6.

4. Choose the Copy Role pushbutton ( \( \text{ } \) ).

5. On the dialog box that opens, specify the target name for the role to be copied, e.g. Z_SMWORK_ITEST.

6. Choose the Copy all pushbutton. You automatically return to the Role Maintenance screen.

7. On the Role Maintenance screen, verify that the correct role name is indicated in the Role field and choose the Change pushbutton ( \( \text{ } \) ).
The Change Roles screen opens.

8. On the Change Roles screen, go to the User tab.

9. In the User ID column, specify the users to which you want to assign the work center and press the Enter key.

**Note**

The status icon on the User Comparison pushbutton indicates whether or not you need to execute the comparison for this role.

If a comparison of the user master records is required (status ‘red’ or ‘yellow’), proceed as follows:

10. Choose the User Comparison pushbutton to run the user comparison. This compares the authorization profiles with the user master records, that is, profiles that are no longer current are removed from the user master records, and the current profiles are entered.

On the Compare Role User Master Record dialog box, choose Complete comparison.
Once the comparison has been run, the following message should be displayed in the status bar at the bottom of the screen:

2.2.2.2 Assign Standard Authorization Roles

You assign authorization roles to your users to determine which applications they can access and which tasks they can carry out in these applications.

SAP delivers standard authorization roles which you can change and modify to meet your needs. These roles contain authorization objects that determine which permissions a user has in an application. You can modify the authorization objects within the roles to change the permissions.

**Recommendation**
Before you assign standard roles (and profiles) to your users, you should copy the standard roles delivered by SAP and adjust them according to your requirements.

SAP delivers the standard roles with default values. However, for some authorization objects default values cannot be delivered so that you have to specify them yourself.
The process of copying roles is explained in chapter 2.2.2.1, steps 3 – 6.

The Solution Manager system contains the following individual roles for Test Management:

- For Test Coordinators/Organizers:
  - SAP_STWB_2_ALL
  - SAP_STWB_2_DIS

- For Testers
  - SAP_STWB_WORK_ALL

- For Information About Tests
  - SAP_STWB_INFO_ALL
  - SAP_STWB_INFO_DIS
  - SAP_STWB_SET_ALL
    These individual roles are contained in the composite roles for implementation.

- For the Test Workbench (Workflow)
  - SAP_STWB_WORKFLOW_CREATE
  - SAP_STWB_WORKFLOW_ADMIN
  - SAP_STWB_WORKFLOW_DIS

- For Business Process Change Analysis (BPCA)
  - SAP_SM_BPCA_RES_ALL
  - SAP_SM_BPCA_RES_DIS
  - SAP_SM_BPCA_TBOM_ALL
  - SAP_SM_BPCA_TBOM_DIS
To maintain the authorization objects for a role proceed as follows:

1. Call up transaction PFCG to access the Role Maintenance screen.

2. In the Role field, enter the name of the role that you want to maintain (e.g. SAP_STWB_WORK_ALL).

3. Choose the Change pushbutton ( ).
   The Change Roles screen opens.

4. On the Change Roles screen, go to the Authorizations tab.

5. In the Maintain Authorization Data and Generate Profiles section, chose the Change Authorization Data pushbutton.

   ![Image of Change Roles screen]

   The Change role: Authorizations screen opens.

6. Make the desired adjustments to the authorization objects.
7. Choose Save.

8. Choose Generate ( ) to generate the profile.

9. On the dialog box that opens, you can change the default profile name and the descriptive short text, if desired.

10. Choose Execute to confirm your entries.

Once you have adapted the roles to your needs and generated the profiles, assign the adjusted roles to the users by following the procedure below:

1. In SAP Easy Access menu, go to SAP menu → Tools → Administration → User Maintenance → Users.

2. Double-click on Users.

3. On the User Maintenance: Initial Screen, specify the user to whom you want to assign roles.

4. Choose Change to access the Maintain User screen in edit mode.

5. On the Maintain User screen, go to the Roles tab.

6. In the Role column, specify the roles you want to assign to the selected user.
7. Press the **Enter** key.
8. Choose **Save**.

### 2.2.3 Activate Workflow Functionality

Using the workflow functionality, a test coordinator can specify actions that the system triggers at pre-defined events in the test management process or during testing. Sending an e-mail is the default behavior. More precisely, the system informs assigned testers about released and locked test packages and test cases.

Therefore, the workflow functionality can help you reduce coordination effort during the test phase and allows you to accelerate test execution.

Before you can use the workflow functionality, some configuration steps need to be performed. First of all, you have to enable the workflow in SAP Solution Manager by activating the appropriate BC Sets and importing piece lists which are prerequisites for the Test Workbench workflow. The Workflow Configuration BC Set includes required system configuration provided by SAP. To activate the BC Set, proceed as described below. All required information for activating the BC Set is also contained in the IMG activity documentation.
Note
Activating a BC Set means touching customizing. Therefore, please check whether the BC Set has already been activated in your system. If it is already active, you do not need to activate it again!

We recommend that you implement customer specific customizing in customer namespace only! If you follow this recommendation activating standard BC Sets cannot harm your customizing.

1. In the SAP Reference IMG, choose SAP Solution Manager Implementation Guide → SAP Solution Manager → Scenario-Specific Settings → Test Management → Extended Configuration → Workflow → Activate Workflow Configuration BC Set.

2. Click on ![image](image.png) to execute the IMG activity. This opens the Business Configuration Sets: Activation screen.

3. In the BC Set field, enter SOLMAN40_TWB_WORKFLOW_000.

Caution
Activating the BC Set will override existing customizing for the Test Workbench Workflow. Therefore, these activities must be performed carefully!

4. Once you have verified that the BC Set is not yet active, you can activate it by choosing the Activate BC Set ![image](image.png) pushbutton.

In addition to activating the BC Set, you should implement SAP Note 1113726 in order to import the required piece list.
To implement SAP Note 1113726, proceed as follows:

5. In your SAP Solution Manager system, launch transaction /nSNOTE.

6. On the Note Assistant: Worklist for User screen, choose the Download SAP Note ![image](image.png) pushbutton.

7. On the Note Assistant: Note Download dialog box, enter 1113726 in the Note number field.

8. Choose Execute.

9. Back on the Note Assistant: Worklist for User screen, expand the New node in the SAP Notes tree and place the cursor on the entry 0001113726 Test Organizer: BC set for workflow (Solution Manager).
10. Choose the *Implement SAP Note* pushbutton.

### 2.2.4 Set-Up Automatic E-Mail Notification for Testers

The setup of automated e-mails is required to enable automated notification for testers participating in testing activities.

This setup step is a prerequisite for Test Management in SAP Solution Manager if you want to use the workflow functionality.

E-mails sent from an SAP application are first sent to a queue. The queued e-mails are then subsequently sent by a periodic background job.

For automatic e-mailing you have to perform the following activities:

a) Set up SAPconnect (chapter 2.2.4.1)

b) Set up a periodic job for SAPconnect (chapter 2.2.4.2)

#### 2.2.4.1 Setup SAPconnect

SAPconnect provides a standard interface for external communication, which supports sending using telecommunication services, such as FAX, text messages (pager/SMS), Internet mail and X.400, as well as sending to printers and between different SAP Systems. It enables external communication components to be connected to the SAP System.

SAPconnect provides a direct connection to the Internet through the SMTP plug-in of the SAP Web Application Server. This enables you to send and receive Internet mails, faxes and text messages (pager/SMS) directly, without having to use additional external communication systems.

To set up SAPconnect for using the workflow functionality proceed as follows:

1. In the SAP Reference IMG, choose *SAP Solution Manager Implementation Guide* → *SAP Solution Manager* → *Cross-Scenario Settings* → *Automatic E-Mail* → *Set-Up SAPconnect.*

2. Click on 📌 to execute the IMG activity.
   This opens the *SAPconnect: Administration* screen.
3. To ensure that you are using the appropriate view, choose View → System status.

![View System status](image)

4. In the menu bar, choose Settings → Default Domain.

![Settings Default Domain](image)

5. Specify your default domain (e.g. <mydomain.com>) and confirm your entry by choosing Continue.

![Continue](image)

6. On the SAPconnect: Administration screen (system status view), double-click on the SMTP node.

![SMTP node](image)

The SAPconnect: General node data screen opens.

7. In the General Information section, specify the Maximum waiting time for repeat send attempt procedure (e.g. one minute).

8. Choose the Node in Use checkbox.

9. In the SMTP Connection section, specify the Mail Host for SMTP (e.g. "mail.mydomain.com").

10. Specify the Mail Port. By default, the port is set to 25.

11. Select the desired entry from the Code Page dropdown box, e.g. 1100 SAP-internal, like ISO 8859-1.
12. In the Supported address types section, choose the Set pushbutton next to the Internet entry. The SAPconnect: Address type for node dialog box opens.

13. In the Address areas text box, enter an asterisk (*).

14. Confirm your entry by choosing Continue.

2.2.4.2 Setup Periodic Job for SAPconnect

The following describes how to schedule the periodic background job to send queued e-mails:

1. In the SAP Reference IMG, choose SAP Solution Manager Implementation Guide → SAP Solution Manager → Cross-Scenario Settings → Automatic E-Mail → Set-Up SAPconnect.
2. Click on 🔄 to execute the IMG activity. This opens the SAPconnect: Administration screen.

3. To ensure that you are using the appropriate view, choose View → Jobs.

4. In the menu bar, choose Job → Create.

5. In the Job name field, specify a name for the periodic job.

6. Confirm your entry by choosing Continue. The SAPconnect send process: Variants screen opens.

7. In the list of variants, select the entry SAP&CONNECTALL.
8. Choose the **Schedule** pushbutton. The SAPconnect send process Scheduling: Start Time screen opens.

9. Choose the **Schedule periodically** pushbutton. The Period Duration dialog box opens.

10. Specify a repeat period, e.g. 10 minutes.

11. Choose the **Create** pushbutton.
2.2.5 Activate BI Reporting

To be able to use BI-based test reporting features, the settings explained below have to be made in advance. Activating the BI reporting capabilities is very easy and does not require BI expertise.

In the below descriptions, the following assumptions are made:

- The standard setup for the BI client in SAP Solution Manager system has been performed in the course of the basic configuration.
- The RFC connection to the BI client is working properly
- The role SAP_BW_CCMS_REPORTING is assigned to the user who wants to perform the activation
- Users in BI client have the following authorizations:

<table>
<thead>
<tr>
<th>Role Name</th>
<th>Type</th>
<th>Purpose/Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP_BI_TWB</td>
<td>ABAP</td>
<td>If you use an external BW system for Solution Manager reporting, you need to download this role to your PC, and upload it to your dedicated BW system.</td>
</tr>
<tr>
<td>SAP_SM_BI_EXTRACTOR</td>
<td>ABAP</td>
<td>This role is generally needed for BW.</td>
</tr>
</tbody>
</table>

**Note**
We recommend that you check SAP Note 1333715 on a regular basis, as this note documents known issues and appropriate solutions with regard to BI Reporting for Test Management.

2.2.5.1 Set BI-Relevant Flag In Release Status Profile

First of all, you have specify the release status values for that BI data shall be extracted. You may, for example, not want to consider test plans that are in status ‘new’.

To specify the BI relevance of the individual test plan status values, proceed as follows:

1. In the SAP Reference IMG, choose SAP Solution Manager Implementation Guide → SAP Solution Manager → Scenario-Specific Settings → Test Management → Extended Configuration → Release Status Profile → Set Up Release Status Profile.
2. Click on to execute the IMG activity.

3. Confirm the dialog box that opens by choosing Continue.

The overview screen for release status schemas for test plans opens.


5. In the list of status schemas, select the desired entry, e.g. DEFAULTS.

Note
By default, SAP delivers the release status schemas DEFAULT (Default Release Schema) and DEFAULTS (Simple Default Release Schema). However, you can also create and maintain your own release status schemas.


7. Select or deselect the BI-Relevant checkbox for each status value as required.
8. Choose Save.

### 2.2.5.2 Setup BI Reporting

To be able to use BI-based test reporting features, you still have to enable and configure the appropriate BI reporting settings. This is done as follows:

1. Call up transaction SOLMAN_WORKCENTER to access the work center, which serves as central access point for SAP Solution Manager.

2. From the navigation bar, choose the Test Management work center.

3. From the navigation area on the left of the screen, choose Settings.

4. From the content area, choose BI Reporting Settings.

The Settings for Test Workbench BI Reporting service opens in a separate window. This service allows you to activate the BI Content. In addition, you can enter the RFC connections from SAP Solution Manager to the BI system and vice versa, and specify when data shall be extracted from SAP Solution Manager every day.
5. Select the **Activate BI Content** checkbox.

6. Choose **Save**.

---

**2.3 Authorizations and User Parameters**

**2.3.1 SAP Solution Manager System**

In addition to the roles and authorizations referred to in chapter 2.2.2 (Setup Work Center for Test Management), the below-mentioned roles must also be assigned to users working with the Work Center.

For a description of how to copy, assign, and maintain roles, please refer to chapter 2.2.2 of this guide.

**Standard Roles for Test Manager:**

<table>
<thead>
<tr>
<th>Role Name</th>
<th>Type</th>
<th>Purpose/Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP_SOL_PM_COMP</td>
<td>ABAP composite role</td>
<td>Organize and plan a project</td>
</tr>
<tr>
<td>SAP_SOL_AC_COMP</td>
<td>ABAP composite role</td>
<td>Create business content and document operational activities</td>
</tr>
<tr>
<td>SAP_SOL_BC_COMP</td>
<td>ABAP composite role</td>
<td>Perform technical configuration</td>
</tr>
<tr>
<td>SAP_SOL_TC_COMP</td>
<td>ABAP composite role</td>
<td>Develop customer-specific programs and authorizations</td>
</tr>
<tr>
<td>SAP_SUPPDESK_DISPLAY</td>
<td>ABAP</td>
<td>Display authorization for Service Desk messages</td>
</tr>
<tr>
<td>SAP_SMWORK_BASIC</td>
<td>ABAP</td>
<td>Basic role for using Work Centers</td>
</tr>
</tbody>
</table>
### Standard Roles for Tester:

<table>
<thead>
<tr>
<th>Role Name</th>
<th>Type</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP_SOL_TESTER_COMP</td>
<td>ABAP</td>
<td></td>
</tr>
<tr>
<td>SAP_STWB_WORKFLOW_CREATE</td>
<td>ABAP</td>
<td>Use Workflow</td>
</tr>
</tbody>
</table>
| SAP_SUPPDESK_CREATE              | ABAP  | Make sure that authorization object B_NOTIF_IB is active and configured as follows: Field *Activity*, values 01, 02, 03  
+ Field *DSWP iBase number*, value * |
| SAP_SMWORK_BASIC                 |       | Basic role for using Work Centers                                       |
| SAP_SMWORK_ITEST                 |       | Role for using Test Management Work Center                               |

For more detailed information on roles and authorizations, please also refer to the Security Guide which can be found on the SAP Service Marketplace at:


### 2.3.2 Managed System

The following authorization objects are required on the managed system:

#### 2.3.2.1 Standard Authorizations

On the managed system, make sure that the below-mentioned standard authorization objects are maintained as indicated.

For a description of how to maintain authorization objects, please refer to chapter 2.2.2.2 (Assign Standard Authorization Roles) of this guide.

- S_DATASET: Authorization for activities 06 and 33 is required.
- S_PATH: Authorization for activities 02 and 03 is required.
To maintain an authorization object, proceed as follows:

1. Call up transaction SUIM to access the User Information System.

2. Expand the node Authorization Objects and choose the By Object Name, Text transaction button.

3. In the Authorization Object field, enter the name of the authorization object that you want to maintain (e.g. S_PATH)

4. Choose the Execute pushbutton.

5. On the screen that opens, double-click on the entry for the authorization object. The Display authorization object screen opens.

6. On the Display authorization object screen, switch to edit mode.

7. Choose the Permitted Activities pushbutton.
8. In the Define Values dialog box, select the activities that you want to enable for the authorization object.

9. Choose the Transfer pushbutton \( \text{ }(\text{Confirm}) \text{) to confirm your entries. You will automatically return to the Maintain authorization object screen.}

10. On the Maintain authorization object screen, choose Save.

### 2.3.2.2 Trusted Authorizations

Trusted RFC is a “contract” between two systems in which the target system agrees to trust connections coming from a particular system. In this case, the logon is permitted without having to enter a password. Since this is a particularly sensitive feature, trusted RFC is protected by an additional authorization check. In order to log on to a trusted system, the user in question must possess the following:

- A user in the target system
- Authorizations for the applications he or she needs to use in the target system
- Authorization for the object S_RFCACL (see table below)

This authorization object regulates a user’s right to log on to a system via trusted connection.

<table>
<thead>
<tr>
<th>Authorization Object</th>
<th>Field</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S_RFC</td>
<td>RFC_TYPE</td>
<td>FUGR</td>
<td>Function group</td>
</tr>
<tr>
<td>RFC Name</td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S_RFCACL</td>
<td>The system ID of the originating system</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RFC_SYSID</td>
<td>The client of the originating system</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RFC_CLIENT</td>
<td>The user in the originating system</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RFC_USER</td>
<td>Flag that indicates whether the user in the target system must be the same as the user in the originating system</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RFC_EQUSER</td>
<td>Transaction code of the application that executed the call</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>RFC Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RFC_TCODE</td>
<td>Activity (only supports 16 – Execute)</td>
</tr>
</tbody>
</table>

| ACTVT | 16 | Execute |

| RFC_NAME | STTF | eCATT auxiliary functions |

| ACTVT | 16 | Execute |
3. Step-by-Step Procedure

This section explains the step-by-step procedure for managing a standard, straightforward software testing cycle using SAP Solution Manager features.

The descriptions below show that building and executing manual tests is easy to learn and requires only little training effort.

The following overview gives you an impression of how much time is required to perform productive manual testing:

<table>
<thead>
<tr>
<th>Productive Manual Testing</th>
<th>Approx. Effort*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project &amp; Solution Documentation</td>
<td>1.5 days</td>
</tr>
<tr>
<td>- Project Creation</td>
<td></td>
</tr>
<tr>
<td>- Business Blueprint</td>
<td></td>
</tr>
<tr>
<td>- Configuration</td>
<td></td>
</tr>
<tr>
<td>Test Planning</td>
<td>0.5 days</td>
</tr>
<tr>
<td>- Test Plan / Package Creation</td>
<td></td>
</tr>
<tr>
<td>- Test Package Assignment to Testers</td>
<td></td>
</tr>
<tr>
<td>- Test Plan Release</td>
<td></td>
</tr>
<tr>
<td>Test Execution</td>
<td>3 days</td>
</tr>
<tr>
<td>- Manual Test Execution</td>
<td></td>
</tr>
<tr>
<td>- Test Status Assignment</td>
<td></td>
</tr>
<tr>
<td>- Message Creation (if required)</td>
<td></td>
</tr>
</tbody>
</table>

* Based on a project comprising 3 processes with an average of 10 process steps per process.

3.1 Project & Solution Documentation

In a first preparatory step, all aspects related to the software tests to be executed must be identified and documented in a well-structured manner.

Solution documentation means having documented key elements, such as core business processes, related technical objects (e.g. transactions, programs, interfaces), and related systems and software components.

Solution documentation consists of two types of documentation, namely:

a) System Landscape Documentation and
b) Business Process Documentation.
We recommend that you follow the “Lean” Solution Documentation approach (see image below):

The system landscape documentation ensures transparency about technical landscape information and serves as the basis for all SAP Solution Manager capabilities along the application lifecycle. As the system landscape documentation is performed as part of the initial SAP Solution Manager setup, the assumption is made that this part of the Solution Documentation has (largely) been completed. An additional step that needs to be performed is assigning the appropriate logical component(s) to a project (see chapter 3.1.1.2 “Define System Landscape”).

A proper business process documentation is performed by defining the Business Blueprint (see chapter 3.1.2).

All testing activities should be planned and organized within the framework of a dedicated project. Therefore, a project in SAP Solution Manager is required as the basis for actual test management.

Again, what is described in the following paragraphs assumes that the relevant system landscape in SAP Solution Manager is known and connected to the central system via RFC destinations.
3.1.1 Create a New Project

Projects in SAP Solution Manager are used to bundle information regarding:
- System Landscape
- Scope (Business Processes)
- Documentation
- Configuration
- Testing
- Training (Learning Material)

Creating projects is supported by the Implementation/Upgrade work center.

3.1.1.1 Define Basic Project Data

As an example, the creation of an implementation project is described below. The following information can, however, be applied to other project types (such as a template project), as the functions in SAP Solution Manager are essentially identical for all types of projects.

1. Call up transaction SOLMAN_WORKCENTER to access the work center, which serves as central access point for SAP Solution Manager.

2. From the navigation bar, choose the Implementation/Upgrade work center.

3. From the navigation area on the left of the screen, choose Plan.

4. From the content area, choose Create or Maintain Project.
   This opens the Project Administration screen.
5. On the Project Administration screen, click on the Create Project icon ( 
).

6. In the Create Project dialog box, enter a project name in the Project field.

From the Type dropdown box, select the appropriate project type, e.g. Implementation Project or Template Project. In the following descriptions, we stick to the example of an implementation project.

Note
It is not possible to change the project type of a project later-on. However, as a workaround, you can copy the existing project and change the project type of the new project.

7. Confirm your entry by choosing Continue.
This opens the maintenance screen for your project (see image below).

8. In the Title field, enter a meaningful project title.

On the General Data tab:

- Project Management
- General Project Information
- Project Status and Project Data
- Plan Data
- Actual Data

THE BEST-RUN BUSINESSES RUN SAP™
9. Specify the *Project Language* by selecting the appropriate entry from the dropdown box. The language you specify here is used as the default maintenance language within the project. The project language cannot be changed later on.

10. Choose Save.

11. Confirm the *Enhancement for Documents* screen by choosing *Continue*.

![](image)

The enhancement context defines where the project documents are saved in Knowledge Warehouse.

Once you have completed these steps, the project “shell” is saved in SAP Solution Manager. You can now maintain additional header data for the project.

### 3.1.1.2 Define the System Landscape

A well-planned, effective system landscape is essential for accessing systems connected to SAP Solution Manager during the Business Blueprint (see chapter 3.1.2), configuration, and testing phases.

For simplicity, the following assumptions are made:

- Solution Manager local SLD is set up and contains technical system information of your managed system landscape
- Managed systems considered for testing are available in Solution Manager Landscape Management (transaction SMSY)
- Logical Components are in place and managed systems assigned to system roles
- RFC destinations from Solution Manager to managed system and vice versa have been created

**Note**

Please be aware that the above-mentioned prerequisites may require additional work from system administration!

The following explanations are limited to the mandatory basic parameters for the project.

1. Choose the *System Landscape* tab.

2. On the sub-tab *Systems*, go to the *Logical Component* column and call up the input help by pressing F4. This opens the *Select Logical Component for System Landscape* dialog box.
3. Select the appropriate entries from the *Logical Components per Product* column.

![Image](image_url)

**Note**
You can also use the search function ( ![Search Icon](search_icon_url) ) to find a logical component or a specific system within a logical component.

![Image](image_url)

4. Choose **OK** to confirm your selection and assign the selected logical components.

5. On the *Central Objects* sub-tab, specify the storage location of objects created in SAP Solution Manager, such as manual test cases.

![Image](image_url)
The default storage location is the solution manager system but can be changed if desired.

Note.
The project administration area also allows you to define project standards. Documenting and approving project standards enables you to ensure that all project team members apply the same standards consistently throughout the project. This improves communication and facilitates evaluation during the project.

Project standards that are relevant for Test Management include the following:

- Status Values
  The default status values can be enhanced with additional values
- Keywords
  Keywords can be used as filter criteria (e.g. when generating test plans and test packages)
- Templates
  You can create your own templates for documentation types Test Case Description and Test Note for Test Case

3.1.2 Business Blueprint
As already indicated before, the Business Blueprint is a detailed description of your business processes and system requirements. It represents the conceptual design of your solution and thus describes how your enterprise wants to map its business processes using SAP and non-SAP systems.

The Business Blueprint is typically designed and changed by Business Process and Quality Experts.

In a Business Blueprint for projects, you create a project structure in which relevant business scenarios, business processes and process steps are organized in a hierarchical structure. You can also create project documentation and assign it to individual scenarios, processes or process steps.

To specify how the business processes shall run in your SAP systems, you assign one or more transactions to each process step.

The following explains how to create the Business Blueprint for your implementation. The description relates to the sample project “Order to Cash Implementation Project” that was previously created (see chapter 3.1.1).

3.1.2.1 Define the Process Structure
To define the hierarchical structure of your business processes, proceed as follows:

1. Call up transaction SOLMAN_WORKCENTER to access the work center.
2. From the navigation bar, choose the Test Management work center.
3. From the navigation area on the left of the screen, choose Test Preparation and select the Projects view.

4. From the content area, choose the All Projects query.

5. Click on Refresh to refresh the active query.
   A list of all projects available in the system is displayed.

6. Click on Filter to display the filter row at the top of the list of all projects.

7. Enter a filter criterion in one of the columns. The use of wildcards is also possible.

Example:
In the Project ID column, enter "O2C*" to filter for all projects with an ID that contains the character string ‘O2C’.

8. From the list of results, highlight the desired project by clicking on the appropriate row.

9. Choose Goto → Business Blueprint to access the Business Blueprint transaction in SAP Solution Manager.
10. In the **Business Blueprint Structure**, go to the **Business Scenarios** level.

11. On the **Structure** tab, enter the name of your scenario in the **Scenario Name** column.

12. Choose **Save**.

**Recommendation:**
We recommend that you first of all create all scenarios and then define the associated processes. Finally, complete your process structure by assigning process steps to the individual processes (see below).

13. In the **Business Blueprint Structure**, drill down to the Business Processes level.

14. On the **Structure** tab, enter your first process in the **Process Name** column.

15. Choose **Save**.
You can now start defining individual business process steps.
16. In the **Business Blueprint Structure**, select the previously defined process.

17. On the **Structure** tab, enter all relevant process steps in the **Step Name** column.

18. Assign the appropriate **Logical Component** to each process step to indicate in which system a process step is to be performed.

19. Choose **Save**.

**Note**
The structure you create during Business Blueprint is re-used in many downstream phases, such as configuration and test planning. Therefore, it is crucial to define the business process structure with care.

### 3.1.2.2 Assign Transactions to Process Steps

The assignment of transactions to business process steps is required for setting up test cases at a later stage.

1. Select the process step to which you want to assign a transaction.
2. Go to the **Transactions** tab.

3. In the **Type** column, select **Transaction** from the dropdown list.

4. Select the appropriate **Logical Component** to specify where the transaction is to be executed.

5. In the **Object** column, enter the appropriate transaction code (e.g. VA01) and press the **Enter** key.
   The transaction you specified is automatically checked in the target system and the transaction name is automatically entered in the **Name** column.

6. Select the **In Scope** checkbox to indicate that the transaction assigned is in scope of your project.

7. Select the **Standard** radio button to set the transaction as the default transaction to be executed for the process step in question.

8. Choose **Save**.

   **Note**
   Once you have assigned a transaction to a process step, an **Execute** icon ( ) is displayed in front of the process step name in the Business Blueprint Structure.

9. Repeat the above-mentioned steps for all business process steps.
3.1.3 Configuration

SAP Solution Manager provides the central infrastructure for configuring your process requirements. The Configuration transaction is used to:

- Define Test Cases
- Assign BC Sets and define configuration/IMG objects for customizing during implementation or upgrade (customizing settings)
- Specify development activities and modifications that are in scope of your project (development objects)
- Assign Business Functions
- Prepare training material for process structure content

The starting point for configuring your business processes is the business process structure that you created in the Business Blueprint, along with all of its assignments. Therefore, configuration requires that the Business Blueprint has been completely created and approved.

In addition, the development system must be up and running.

The above-mentioned information can be referenced from each level of the business process structure (scenario, process, process step).

For the purposes of this document we will focus on creating and assigning manual test cases.

3.1.3.1 Define and Assign Test Cases

You can create entirely new documents or upload existing documents that contain instructions to help manual testers perform tests.

Test Cases are assigned to scenarios, processes, or process steps and form the basis for the test planning and execution phases.

To assign a test case to the process structure, proceed as follows:

1. Call up transaction SOLMAN_WORKCENTER to access the work center.
2. From the navigation bar, choose the Test Management work center.
3. From the navigation area on the left of the screen, choose Test Preparation and select the Projects view.
4. From the content area, choose the All Projects query.
5. Click on Refresh to refresh the active query.
   A list of all projects available in the system is displayed.
6. Click on Filter to display the filter row at the top of the list of all projects.
7. Enter a filter criterion in one the columns. The use of wildcards is also possible.

**Example:**
In the *Project ID* column, enter "O2C" to filter for all projects with an ID that contains the character string 'O2C'.

8. From the list of results, highlight the desired project by clicking on the appropriate row.

9. Choose *Goto → Configuration* to access the Configuration transaction.

10. In the *Configuration Structure* on the left side of the screen, drill down to the level where you want to assign the test case.

**Example:**
To assign a test case to the ‘Create Sales Order’ process step of our sample project, choose *Business Scenarios → Logistics → Business Processes → Order to Cash → Create Sales Order* in the *Configuration Structure*. 
11. Choose the Test Cases tab.

12. In the Test Case Type column, select the option Test Document from the dropdown list to set up a test case for manual testing.

13. In the Add Document dialog box, specify whether you want to create a new document or upload an existing one by selecting the appropriate radio button.

14. Enter the Title of the document to be created.

15. In the Documentation Type field, select the option Test Case Description.

16. In the Status field, select the value Released.
17. Confirm your entries by choosing OK (✓).
    In our example, a new document is created and the default template for test notes opens in the
document editor.

18. Fill in the template with the appropriate instructions and information.

![Test Case Example]

19. Choose Save.


To finalize the test case, the actual object which is to be tested needs to be identified as follows:

22. In the Test Object column, place the cursor in the cell of your test case.

23. Press F4 to call up the input help (Select Test Object dialog box).

Note:
You can only assign test objects which are assigned to the same structure element in the
Transactions tab. Therefore, it is crucial that the Transactions tab has been properly
maintained.
24. Choose the *Copy* pushbutton (✔️) to assign the transaction as test object.

25. Choose *Save*.

26. To check the test case you previously created, highlight the line containing your test case and choose the *Display* pushbutton (☐).

**Note:**
Since the number of test cases usually increases as time goes by, you can also assign a range of attributes to make the test cases easier to catalog and locate.

### 3.2 Test Planning

Once the test focus resulting from the planned changes is known, the relevant test cases can be identified. Based on the test cases, you can generate test plans and test packages.

All activities regarding planning of manual tests are supported by the SAP Solution Manager Test Workbench (TWB).

#### 3.2.1 Create a Test Plan

Test Plans serve as central objects for activities related to planning and coordinating tests. They are used to group all relevant test cases for an actual test cycle. In other words, a test plan contains the scope of a test cycle, based on the test cases assigned to the business process structure. Hence, all test plans that you create during test planning are based on the Business Blueprint project structure.

During test plan generation, the transactions you previously assigned to the process structure are put in the test plan(s).

The following describes how to create a test plan using the Test Workbench in SAP Solution Manager:

1. Call up transaction SOLMAN_WORKCENTER to access the work center.
2. From the navigation bar, choose the Test Management work center.

3. From the navigation area on the left of the screen, choose Test Plan Management.

4. In the content area, click on Test Plan and choose Create Test Plan from the context menu. The Create test plan dialog box opens.

5. Under Template, make sure the name of the (implementation) project you previously defined is selected in the Project field.

6. Under General Data, in the Test Plan Header Data section, specify a Title for the test plan you are about to create.

7. Under General Data, in the Release section, select an entry from the Status Profile dropdown box, e.g. DEFAULTS.

   Note:
   Using a release status schema is required if you want to use the workflow functionality.

8. Under Defaults, in the Settings section, select the Only Released Test Documents checkbox to indicate that only released test documents shall be taken into account during generation of the test plan.

9. Confirm your entries by choosing Continue (✔️).
10. On the test plan creation screen, choose the Expand All pushbutton (.expand_more) to expand the Test Plan Structure on the left of the screen.

11. In the Test Plan Structure, select the test cases that shall be in scope of the test plan.

12. Once you have defined the scope, choose the Generate Test Plan pushbutton (.expand_more).

13. In the Create Object Directory Entry dialog box, choose Local Object. You will automatically be returned to the Test Plan Management area within the Test
Management work center.


15. Click on *Refresh* to refresh the active query.
   The test plan you have just created is displayed in the table.

16. In the *Test Plan* column, click on your test plan.
   The *Test Plan Attributes* screen opens.

17. Choose the *Change* pushbutton (📝) to switch to edit mode.

18. In the *System Role* field, make sure the correct entry is selected.
   The system role defines which system is used as the system under test.

19. Select the *Workflow Active* checkbox to enable the workflow function for your test plan. The workflow functionality can specify and start actions at specified events in the test management process or during testing. Sending an E-mail is the default value. When the *Workflow Active* checkbox is selected, automatic e-mail notifications are sent to the relevant testers when packages are assigned to them or the status of the test plan changes.

⚠️ Note:
You can only activate the workflow if you are using a release status schema.
20. Choose Save.

21. Choose the Exit pushbutton ( ) to return to the work center.

3.2.2 Create a Test Package

Test packages are used to assign manual test cases to selected testers. A test package contains all the test cases that a tester is to perform within a specific time period. One and the same test package can be assigned to various testers.

Test packages can be created based on the test cases that are included in the test plan.

Once a test package has been assigned to a tester, the tester can see his or her assignment(s) and the relevant test cases in the Tester Worklist.

1. Call up transaction SOLMAN_WORKCENTER to access the work center.

2. From the navigation bar, choose the Test Management work center.

3. From the navigation area on the left of the screen, choose Test Plan Management.

4. Choose the My Test Plans query.

5. Highlight the desired test plan.

6. Choose Test Package Management.

The Test Package Management – Test Organizer screen opens.

7. Choose the Create Test Package pushbutton ( ).

The project structure underlying your test plan is displayed.

8. Choose the Expand All pushbutton ( ) to expand the structure.

9. Select the nodes that are relevant for your test package.
10. Once you have made your selection, choose the Generate pushbutton. The Create Test Package dialog box opens.

11. In the Title field, enter a short description for the test package.

12. Choose Continue.

13. In the Create Object Directory Entry dialog box, choose Local Object. You will automatically be returned to the Test Package Management – Test Organizer screen where you can assign the newly generated test package to one or more testers (see next chapter).

### 3.2.3 Assign Test Package(s) to Tester(s)

A test package is usually assigned to one tester. The tester finds this test package as a work list in the Test Management work center. You can also lock or delete a test package for a tester.

**Note:**
Test package assignments are client-specific.

1. Call up transaction SOLMAN_WORKCENTER to access the work center.

2. From the navigation bar, choose the Test Management work center.

3. From the navigation area on the left of the screen, choose Test Plan Management.

4. Choose the My Test Plans query.
5. Highlight the desired test plan.

6. Choose Test Package Management.

The Test Package Management – Test Organizer screen opens.

7. Select the test package to be assigned.

8. Choose the Assign Tester pushbutton (       ).

The Restrict Value Range dialog box opens.

9. In the User field, enter the user name of the tester to whom you want to assign the test package.

10. Choose Continue.
11. Select the appropriate entry from the Hit List.

12. Choose the Copy pushbutton (                ).

The tester assignment is put in the hierarchy.

Note:
If you use different test packages to assign one and the same manual test case to multiple testers, it may happen that their results differ. In that case, the worst result is applied as the overall status of the test case. If the different statuses are OK, OK with Reservations, and Untested, the overall status is set to OK.

Once a test plan is released, the test packages that are included in the test plan can be executed by the assigned testers.

### 3.2.4 Release your Test Plan

Before the testers are able to test their assigned test packages, the relevant test plan needs to be released.
This is usually done via the release status schema assigned to the test plan.

The following describes how to release a test plan. For the purposes of our example, the release status profile ‘DEFAULTS’ is used.

1. Call up transaction SOLMAN_WORKCENTER to access the work center.
2. From the navigation bar, choose the Test Management work center.
3. From the navigation area on the left of the screen, choose Test Plan Management.
4. Choose the My Test Plans query.
5. Highlight the desired test plan.
6. Choose Goto → Attributes.
The Test Plan Attributes screen opens.

7. Choose the Change pushbutton ( ) to switch to edit mode.

8. On the General Data tab, place the cursor in the Status field.

9. Press F4 to call up the input help.

10. Select the entry RELEASED.

11. Choose the Copy pushbutton (✓) to confirm your selection.

12. Choose Save.
   The test plan is released and thus no longer locked for test execution.
   If the Workflow Active checkbox has been selected, e-mail notifications are automatically sent to assigned testers to inform them that their test packages are available and ready for testing.
If the *Workflow Active* checkbox has been selected, e-mail notifications are automatically sent to assigned testers to inform them that their test packages are available and ready for testing.

**3.3 Test Execution**

As soon as the tests have been planned and the test systems are available and contain adequate test data, actual testing can start.
The Test Workbench in SAP Solution Manager provides functions that enable you to perform tests, enter problem messages, create test logs, and handle test status management as well as status reporting.

The test case description provides testers with all information they need to carry out the (manual) tests.

After performing a test, testers can log and document the test results (including screenshots, if required) in a test note.

The test activities are completed by setting the appropriate test status, which serves as the basis for the test coordinator’s test reporting activities.

### 3.3.1 Perform a Manual Test

The Tester Worklist ensures access to both the test cases and the transactions in the system under test (managed system). It contains an overview of all test packages that have been assigned to you for testing.

As a test organizer, you are authorized to view all test packages.

The following describes how to perform a test from the tester worklist within the Test Management work center:

1. Call up transaction SOLMAN_WORKCENTER to access the work center.
2. From the navigation bar, choose the Test Management work center.
3. From the navigation area on the left of the screen, choose Tester Worklist.
4. Choose the My Assigned query.
5. Click on Refresh to refresh the active query.
6. Highlight the desired test package in the list of test packages that are assigned to you.
7. Choose Run Test.

The Perform Test screen opens.

8. Choose the Expand All pushbutton ( ) to see all test cases that are contained in your test package.
9. In the Test Case Description column, click on the Test Document icon ( ) for the desired test case to open the associated test case description.

10. In the Test Object column, click on the transaction name to call up the transaction in the system under test.

**Recommendation:**
You can tile the windows side-by-side so that you can read through the test case description and carry out the test in the managed system in parallel.

11. After you have performed the test, choose the Exit pushbutton ( ) to quit the transaction in the system under test, and close the test case description by clicking on ( ).

Once the test case has been executed, a status needs to be assigned (see next chapter).
3.3.2 Set Test Status

To assign a status to a test case, proceed as follows:

1. In the Status column on the Perform Test screen, click on the status icon (○○○) next to the executed test item. This opens the Status Maintenance screen.

2. On the Status tab, select the appropriate entry from the Status dropdown box, e.g. OK if the test was successfully completed.

   ![Status Maintenance Screen]

   **Note:**
   The statuses available can be customized according to your needs. The statuses displayed above are the default entries delivered by SAP.

3. In the Test Effort field, enter the amount of time required to complete the test.

   **Note:**
   The entry can be in terms of minutes or hours.

4. If desired, enter a short text in the Comment field.

5. Choose Save.

If problems occur during test execution and the test cannot be completed successfully, you can create a test message, which is automatically linked to the relevant test case.
3.3.3 Create a Message

If the test fails, assign the Status Errors. Retest Required and choose Save.
The system automatically prompts you to create a message for the failed test.

Test messages are used to report errors to SAP so that the relevant developer can fix the problem.

To create a message that provides more details on the detected error(s), proceed as follows:

1. On the Status Maintenance screen, go to the Messages tab.

2. On the Messages tab, choose Create Message ( ).
The Create Support Message dialog box opens.

3. In the Priority field, call up the input help by pressing F4 and select the appropriate entry.

4. In the System/IBase field, call up the input help by pressing F4 and select the desired entry from the Data Selection tree.

5. Choose OK to confirm your selection. Based on your selection in the System/IBase field, the Installation Number, SystemID, and Client fields are automatically populated.

6. In the Component field, call up the input help by pressing F4 and select the appropriate entry.

7. In the Reported by field, check whether the correct business partner/name is displayed. By default, the user creating the message is automatically entered in this field.
8. If desired, make entries in the Processor, Category, and Subject fields.

9. In the Short Text field, enter a short description of the problem you want to report.

10. On the Long Text tab, enter a detailed description of the error into the text box. Basic information, such as the names of the relevant test plan, test package, and test case are already pre-filled on the Long Text tab.

11. If desired, upload a file attachment using the Attachments tab.

12. Choose Save. A success message shows up in the status bar at the bottom of the screen, and your message is displayed on the Messages tab.

13. Choose the Exit pushbutton ( ).
    You will automatically be returned to the Perform Test screen where a yellow flash icon is displayed next to the status icon to indicate the existence of a message.
3.3.4 Create a Test Note

Test Notes are used to document the test results, thus ensuring transparency and traceability. Apart from that, in many companies an accurate and thorough documentation of test results is required for legal reasons (e.g. in the pharmaceutical industry). Test Notes can also be used to handover data that is needed for subsequent testing activities.

The following describes how to create a test note:

1. On the Status Maintenance screen, choose the Create Test Note pushbutton.

2. On the Add Document dialog box, verify that the short text specified in the Title field is appropriate or enter a new title.

3. In the Documentation Type field, make sure that Test Note for Test Case is selected.

4. In the Status field, select the appropriate entry from the dropdown box.

5. Select the desired radio button to specify whether you want to create a new document, upload an existing file or copy the test document (i.e. test case description) to use it as a template for creating the test note.
6. Choose **OK** to confirm your entries. The *Edit Document* screen opens.

7. Enter all information that helps document and log your test, such as transaction data used for test execution.

**Note:**
You can also add screenshots to the test note.

8. Choose the *Save Document* pushbutton ( ![Save Document](screenshot) ).

9. Choose the *Close Document* pushbutton ( ![Close Document](screenshot) ).

10. Confirm the *Document* dialog box by choosing *Yes*. You will automatically be returned to the *Status Maintenance* screen.

11. Choose the *Exit* pushbutton ( ![Exit](screenshot) ). You will automatically be returned to the *Perform Test* screen where an icon in the *Note exists* column indicates that a test note is available for the test case.
3.4 Test Reporting

Throughout the test cycle, test coordinators monitor the test status and progress. In addition, they keep an eye on the processing status of problems that have been reported.

The Test Workbench provides a wide range of hierarchical and list-based reports that help you control the test execution status. As a test coordinator you can use these reports to track the progress of testing at all times – even if tests are being conducted in different locations around the world.

In addition, you can analyze the number and priority of problems that have occurred during testing. Further reporting capabilities are enabled by the integration between Test Workbench and SAP NetWeaver Business Intelligence (BI).

Each role involved in a project (such as test coordinator, quality manager, project lead, CIO) is interested in different pieces of information and requires a different level of granularity when it comes to data on test status, test progress, and error messages. A quality manager, for example, might be interested in the progress of error message solving, whereas a project lead probably wants to know what the overall testing progress looks like.

To meet the needs of all project members, SAP Test Workbench offers a range of tools and functions that provide information on both aggregated and detailed level.

Test reporting capabilities in SAP Solution Manager comprise the following:

- Different entry levels (Project, Solution, Test Plan)
- Drill-down capabilities to access individual test cases and error messages
- Status Analysis featuring both absolute values and percentages
- Integration with SAP BI that allows for graphical representation of test progress etc.

The following describes the most common use cases for test reporting and explains how to use the appropriate Test Workbench functions to obtain the requested information:

3.4.1 Check Test Case Coverage for Business Processes

To gain reliable test results it is crucial to ensure transparency during test scope definition and test planning. Checking to what extent your business processes are covered by test cases allows you to
To check the completeness of your test scope proceed as follows:

1. Call up transaction SOLMAN_WORKCENTER to access the work center.

2. From the navigation bar, choose the Test Management work center.

3. From the navigation area on the left of the screen, choose Test Preparation and select the Projects view.

4. From the content area, choose the My Projects query.

5. Click on Refresh to refresh the active query. A list of all projects assigned to you is displayed.

6. From the list of results, highlight the desired project by clicking on the appropriate row.

7. Choose the Evaluate pushbutton. This opens the Evaluate Transactions / TBOMs / Testcases screen.

8. At the bottom of the screen in the Test Cases section, select the Nodes without Test Cases radio button.
9. At the top of the screen, choose **Execute ( ))**. The results screen opens.

10. Select the topmost element in the **Project Structure** column and choose **Expand subtree ( )**. All business processes that have no test case assigned to them (no ‘X’ in **Test Cases** column) are displayed.

   ![Image of Project Structure column with Expand subtree option selected]

   This allows you to see at a glance what still needs to be done to complete the test scope definition.

### 3.4.2 Check Assignment of Test Cases to Test Plans and Test Packages

The Test Workbench functions enable you to find out whether there are test cases which are not included in a test plan or test package.

To create a negative list of test cases that are not assigned to a test plan or test package, proceed as follows:

1. Call up transaction SOLMAN_WORKCENTER to access the work center.

2. From the navigation bar, choose the **Test Management** work center.

3. From the navigation area on the left of the screen, choose **Reports**.

   ![Image of SAP Solution Manager: Work Centers with Reports selected]

4. In the content area, go to the **Description** column and drill down to **Test → Project Status Analyses**.
5. In the *Type* column, click on *Report*. This opens the *Test Case Status Analysis* screen.

6. In the *Project* field, make sure the correct project name is entered.

7. In the *System Role* field, verify that the desired system role is selected.

8. In the *Status Attributes* section, select the *Not Assigned to a Test Package* and *Test Case in No Test Plan* checkboxes.

9. At the top of the screen, choose *Execute* ( ). The results screen opens.

10. Select the topmost element in the *Project Structure* column and choose *Expand subtree* ( ). A list of test cases without assignment to test plans or test packages is displayed.

A remark in the *Status Text* column indicates what kind of assignment is still missing for the relevant test case.

### 3.4.3 Check Status for Current Test Phase

The Status Info System within SAP Solution Manager offers an efficient and flexible way of getting a snapshot of current test activities and related messages.

To get an overview of the latest test-relevant information, proceed as follows:

1. Call up transaction SOLMAN_WORKCENTER to access the work center.
2. From the navigation bar, choose the Test Management work center.

3. From the navigation area on the left of the screen, choose Test Evaluation. The view that opens contains an overview of all test plans and the status of the corresponding test cases on an aggregated level. To evaluate the test plans on a more granular level, various tools are available, which will be explained in more detail below.

![SAP Solution Manager: Work Centers](image)

**Note:**
The Test Evaluation area within the Test Management Work Center is the central place to access most of the test reporting tools. The Work Center provides a high degree of flexibility when it comes to personalization and the definition of own queries.

4. In the content area, search for the desired test plan and highlight the appropriate row. If required, use the filter functionality to find your test plan.

5. Choose Goto → Status Overview. This takes you to the Status Overview – Test Organizer screen.

![Status Overview - Test Organizer](image)

This view provides you with high-level status information on the results of the selected test plan and its associated test packages. It also indicates whether problem messages have been created for the test phase.

**Recommendation:**
You can toggle between absolute values and percentages: From the menu bar, choose Utilities → Settings → Status… and select the desired radio button.
Further Options - Detailed **Status Analysis.**

6. To obtain more detailed information place the mouse pointer on either the test plan (top level node) or a test package in the structure.

7. Choose the **Status Analysis** pushbutton ( ![Status Analysis](image) ). This opens the **Status Analysis** screen for the selected test plan/test package.

The **Status Analysis** screen provides you with all kinds of test-related data (such as test status, result documentation, availability of messages and notes, etc.) and allows you to drill down to individual test cases.

### 3.4.4 Check Messages for Test Plan

To obtain an overview of all messages related to your test plan/test package proceed as follows:

1. Call up transaction SOLMAN_WORKCENTER to access the work center.
2. From the navigation bar, choose the **Test Management** work center.
3. From the navigation area on the left of the screen, choose **Test Evaluation.**
4. In the content area, search for the desired test plan and highlight the appropriate row. If required, use the filter functionality to find your test plan.

5. Choose **Goto → Message Overview**. This takes you to the **Message Overview** screen.

The **Message Overview** screen provides you with detailed information, such as message status, priority, reporter, etc.

6. To display all details of a specific message, select the desired entry and choose the **Details** pushbutton ( ).

To get an overview of the latest test-relevant information, proceed as follows:

### 3.4.5 Create a Test Report

The test report function uses an MS Word macro that allows you to comprehensively document the current results of a test plan. All relevant data (such as test case descriptions, test notes, etc.) are downloaded to a local directory and then consolidated in a central document. The structure of the document is based on the business process structure of the underlying project.

The test report function is particularly useful for companies that have an obligation to produce supporting documents, as the test report reflects a “frozen” status of test activities at a specific point in time. Therefore, the test report helps you meet legal requirements for test documentation.

To create a Test Report, proceed as follows:

1. Call up transaction SOLMAN_WORKCENTER to access the work center.

2. From the navigation bar, choose the **Test Management** work center.
3. From the navigation area on the left of the screen, choose *Test Plan Management*.  

4. Choose the *My Test Plans* query.  

5. Highlight the desired test plan.  

6. Choose *Goto → Create Test Report*.  

7. In the *Test Report Display Options* dialog box, specify what pieces of information shall be included in the report by selecting or deselecting the various checkboxes.  

8. Choose *Execute*.  
   The *Download Test Report* dialog box opens.
9. Confirm the message by choosing *Continue*.
The test report document automatically opens provided that you have Microsoft Word installed on your machine.

10. In MS Word, make sure you have macros enabled.

11. As soon as macros are enabled, run the Macro `SAP_GENERATE_TESTREPORT`.
The complete test report is displayed. You can now save the document on your harddrive or print it and have it signed.
3.4.6 Use Test Reporting Features Based on SAP BI

You can analyze test management using the BI reporting analyses which allow you to access various graphic overviews and extensive filter capabilities. You also have access to the functions of the BI system. These tools are particularly useful for quality managers and test organizers.

3.4.6.1 Status Report

The Status Report shows an overview of the status of selected test plans including a message overview for priority 1 – 3 messages.

This report provides an efficient and flexible way to visualize the test status on a day-to-day basis.

To call up the BI-based status report, proceed as follows:

1. Call up transaction SOLMAN_WORKCENTER to access the work center.
2. From the navigation bar, choose the Test Management work center.
3. From the navigation area on the left of the screen, choose Test Evaluation.
4. In the content area, select the test plan for that you want to perform the status reporting.
5. Choose the Status Report pushbutton and, from the context menu, select the option Test Plans.
The BI report for the current status of the selected test plan is displayed in a new window. The report also includes a message overview for priority 1 – 3 messages.

By default, data is displayed for the date of the last data extraction.

Using drilldown and filter functionalities, you can adjust the view on the data to obtain different levels of granularity.

In addition, detailed information is displayed in a tabular overview at the bottom of the screen.

### 3.4.6.2 Progress Report

The progress report displays the progress of the test case status over a certain period. The progress report can, for example, support project leads and test coordinators in detecting potential delays.

To call up the BI-based status report, proceed as follows:

1. Call up transaction SOLMAN_WORKCENTER to access the work center.
2. From the navigation bar, choose the *Test Management* work center.
3. From the navigation area on the left of the screen, choose *Test Evaluation*.
4. In the content area, select the test plan for that you want to perform the status reporting.
5. Choose the Progress Report pushbutton and, from the context menu, select the option For Selected Test Plans.

![Progress Monitor](image)

The BI report for the test progress of the selected test plan is displayed in a new window.

![Graphical Overview](image)

By default, the last 30 days are set as the filter.

Using drilldown and filter functionalities, you can adjust the view on the data to obtain different levels of granularity.

In addition, detailed information is displayed in a tabular overview at the bottom of the screen.
3.4.6.3 Messages Report

The messages report shows an overview of the number and status of test-related messages at a certain time. By default, the data of the last data extraction is set as the filter. The messages report can be displayed for selected projects or test plans.

3.4.6.4 Messages By Priority Report

This report provides an overview of the number and priority of messages at a certain time. It shows test-related incident messages by priority per test plan.
Further Help
For further help please refer to the following links (some of the links are accessible to SAP Customers and Partners only):

- SAP Standard for Test Management

- E2E Integration Testing
  - [http://service.sap.com/testing](http://service.sap.com/testing)

- Ramp-Up Knowledge Transfer - SAP Solution Manager 7.0 - EHP1: Build, Test and Deploy with SAP Solution Manager
  - [http://service.sap.com/rkt-solman](http://service.sap.com/rkt-solman) → SAP Solution Manager 7.0 - Enhancement Package 1 (EHP1) → Build, Test and Deploy with SAP Solution Manager

- SAP Solution Manager
  - [http://service.sap.com/solutionmanager](http://service.sap.com/solutionmanager)